Amira 5.2.1 — Release Notes

Release Date: March 2009

Supported Platforms
e Windows — Windows® 2000/XP/Vista, 32-bit and 64-bit editions

e Mac OS — Mac OS® X 10.5 (Leopard) with Intel CPU
e Linux — Red Hat Enterprise Linux 5.2 for x86_64 or compatible; the software can work on

other distributions too, but it is not guaranteed and verified.

System Requirements
e CPU supporting SSEZ2 instruction set. (Intel Pentium 4 and above or compatible)

e Atleast 512 MB RAM
e Graphics card with OpenGL support and hardware accelerated texture mapping. Some
visualization modules require graphics hardware with recent vertex and fragment shader

support and a recent driver.

Recommended Hardware
e CPU - Multi-core CPU with 2 GHz; On Mac OS X an Intel CPU is recommended.

e Memory - 2 GB RAM

e Graphics card - A current "gaming" card from one of the main vendors (NVIDIA or ATI) with
at least 512 MB video RAM is recommended. If OpenGL stereo support is needed (e.g.
stereo projection or AmiraVR), an NVIDIA Quadro FX or an ATI FireGL / FirePro card with

the appropriate driver must be installed.

Supported Compilers for Developer Option
In order to add custom extensions to Amira using the Developer Option, a C++ compiler is

required. The following C++ compilers are supported:
¢ Windows — Microsoft Visual Studio 2005 (VC++ 8.0).
e Mac OS X — GNU gcc 4.0.x with the latest version of XCode provided by Apple
e Linux — GNU gcc 4.1.x
Details about the supported compilers and compiler versions can be found in the section System

Requirements of the Amira Developer's Guide.



Changes since Amira 5.2.0

Enhancements

GUI/Layout: Now the minimal size of the main panel depends on the current sub-
application. The size set by the user is remembered throughout an Amira session.
Segmentation Editor/Magic Wand Tool: Due to multiple user requests, the behavior of
the Magic Wand tool for disabled masking has been reverted to that of Amira 4.x. Now, the
user has two choices:

1. Masking is disabled: The user can click in a 2D viewer and the selection is
performed according to the data range slider in the Display and Masking area.
Changing the slider immediately triggers a selection update. With all slice’' checked,
the update occurs on mouse button release.

2. Masking is enabled: The tool works as introduced with Amira 5. The voxels falling
into the range of the data range slider are visually highlighted in the 2D viewers by
a blue semi-transparent overlay. By clicking into one of the highlighted areas the
user can set the seed point for the Magic Wand algorithm. When changing the
slider widget, the user has to click again to update the selection.

The latter method is advantageous for large data sets where an immediate update takes
too much time and therefore hampers interactivity. The mask highlight gives a visual
preview of the expected selection. In both cases, a vertical red bar in the data range slider
indicates the intensity of the clicked voxel.

Segmentation Editor/Lasso tool: After the unification of 2D Lasso and 3D lasso in

Amira 5.0, the keyboard modifier Ctrl was no longer inverting the draw action. In the current
release, the user interface has been adapted. Now, the default lasso mode is Add, i.e.
drawing together with the Ctrl key pressed removes the selection. In the Tool Box there are
two radio buttons that let the user change the 3D mode from Inside (default) to Outside,
meaning that draw actions (either add or remove) act on the inside or outside of the
contour, respectively. When masking is enabled the default inside mode is replace with
respect to the mask and the default outside mode is remove.

Segmentation Editor: The automatic assignment of material colors sometimes generated
very similar colors. Now the algorithm has been improved to guarantee maximally different
colors in subsequent materials.

Voltex: Port Number of slices slider now accepts a maximal value of 512 to account for the
increased performance of average graphics cards. Note that this maximum can be altered
at any time by right clicking into the slider and selecting the Configure item of the context

menu.



Multi-Planar Viewer/ Auto Registration tool: The results of intermediate transformations
during the iterative search are now visible in all viewers.

CalculusMatlab: This module is now available on Linux and Mac OS X platforms.

Tiff reader: TIFF images containing 32-bit float data can now be read.

Deconvolution: The deconvolution of short or unsigned short data scales its output to the
maximum of the respective data type (32767 or 65535). Microscopy data, however, are
typically digitized with 12-bit accuracy corresponding to a maximum of 4095. Thus, the
result of a deconvolution is hard to compare with the original data. Now the input data is
checked with respect to the absolute data range and the result is divided by 16 if the data
falls into the 4096 data range.

OrthoSlice: When OrthoSlice was reconnected, it always reset the data window, which
hampered the comparison of different data sets. Now, OrthoSlice sets a new data window
on reconnection only if the data type of the new data object is different.

DemoMaker: The buttons of port Event List were reordered to make the most frequently
used buttons Add and Replace stand in the first place.

Mesh Option/GridVolume: The initial display of module GridVolume showed only the red
wire frame of the tetrahedral grid. This behavior has been made consistent with that of

SurfaceView. Now GridVolume initially shows the shaded geometry.

Bug fixes
Unless otherwise indicated, the bugs listed below have been fixed such that the behavior

described is no longer encountered.

Segmentation Editor

Magic Wand: After changing the Image Data, the Magic Wand tool behaved as if the old
image data were still active.
Panning: If the panning tool was selected from the viewer tool bar it was not possible to
disable it again.
Magic Wand: Shift clicking a voxel outside the masking window destroyed a previous
selection. The behavior has been corrected and improved:
1. Masking is enabled: Irrespective of the Shift-key state, a pick on a pixel outside the
masking data window will not change anything.
2. Masking is disabled: It is possible to set seed voxels outside the masking data
window resulting in a void selection. By default, existing selections are replaced.
Thus, clicking outside the current range clears the current selection and

simultaneously holding down the Shift key prevents this.



Amira for Microscopy (ResolveRT)

FourierTransform: This module did not show port Mode when attached to a data object
loaded as an MRC volume.

MRC reader: The reader for the MRC file format incorrectly initialized the default data
window of the resulting data object.

Leica LIF reader: Files larger than 2GB can now be read.

Zeiss ZVI reader: Attempting to load recent files of the ZVI file format crashed Amira. The
existing reader can only import ZVI files from earlier versions of the format. The reader has
been changed to output an error message when unsupported ZVI files are attempted to be
read.

Filament Editor: Rank statistics was not updated after a Set Root command had been

applied to a different segment.

Quantification+ Option

Quantification: Module Quantification could not be used without Administrator privileges.
Quantification-Threshold: The output objects of module Quantification-Threshold were
not "visible" to some filters of the quantification module so that it was impossible to further
process these outputs with Quantification.

Demos: The directories share/demo/mousse and share/demo/mousse2 and the scripts

they contained were missing.

Skeleton Option

Autoskeleton: Module Autoskeleton was crashing Amira when attached to an object with

float data. Now Amira issues an error message when such an attachment is attempted.

Developer Option

Debug Libraries: For debugging, a user's module was compiled in debug mode but linked
against Amira libraries that had been built in release mode. To start debugging, Amira had
to be called with the '-debug' option. This occasionally led to crashes. Now in AmiraDeyv all
debug libraries have been added to the distribution in the directory "bin/arch-
<name_of_architecture> -debug". To start a debugging session, call amiramain from that

directory.

Mac OS X

FLEXNet: The FLEXNet binaries were missing.



Linux

External drives such as USB sticks and USB hard drives were not listed in the File
Browser's list of drives. It was necessary to manually type /Volumes to get a listing of
external drives.

Spin Animation: The state of the viewer's spin animation feature was not remembered for

the next Amira session.

Colormap Options: The Options item of any colormap port did not activate a secondary

menu when selected.

Various modules

AlignSlices caused a crash when attached to LDA data objects.

ApplyTransform crashed on data where one dimension had voxel size 0.

Histogram: Networks containing a Histogram module with an open plot window were
incorrectly saved.

Histogram: Checking the option +cumulative in module Histogram before opening the plot
window (via apply) led to a crash.

LandmarkSurfaceWarp crashed when disconnecting the input data.

LabelVoxel: Pressing the “Apply” button of module LabelVoxel twice led to an invalid result
object, which module SurfaceGen refused to process (Error message in the console:
“lllegal data type. Cast to label-field, unsigned char, or unsigned short!").
LegoSurfaceGen created triangles with incorrect orientation at borders.

Measurement: Under certain conditions, removal of module Measurement crashed Amira.
MovieMaker: On Windows, Amira crashed when module MovieMaker was attached and
the user had no Administrator privileges. Technically, administrator privileges were never
necessary for MovieMaker.

ProjectionView: The commands to control ports Min.slice and Max.slice, which are shown
when the restrict option is checked, were not working.

SurfaceGen created a material Exterior2 even when the add border option was
deselected.

Volren did not correctly handle inverted color map ranges (minimum larger than

maximum). The rendering was identical to the uninverted case.

GUI and general components

Extra Viewer: An extra viewer as created by View->Layout->Extra Viewer could not be

minimized because the buttons in the window title bar were missing.



Colormap Editor: Clicking onto a color or opacity marker made the marker jump one cell
to the left or right.

Multi-channel DataWindows: During saving and reloading a multi-channel object as
AmiraMesh, user-defined per-channel min/max got lost.

3D Viewer: Switching between orthographic and perspective camera did not properly
conserve the camera perspective.

User’s Guide: Some pages of the User's Guide were not accessible from the Table of
Contents.

File Names: When labels of data objects contained colons (:') and were saved, they
became hidden files on Windows. Now colons in object names are replaced with
underscore ('_') characters.

Window Layout: Changing Amira's overall layout to separate windows for Main Panel, 3D
Viewer and/or Console (Edit->Preferences->Layout) automatically maximized the main
window.

Measurement: When selecting Measure from the View menu a Measurement module was
created but the tool was not yet active in the viewer. The user had to activate the tool by
clicking onto the tool icon in the viewer tool bar.

Measurement: When OpenGL stereo was enabled, the labels of measurements in the
viewer disappeared and did not return when stereo was switched off.

3D TIFF Series Loading: During loading a series of 3D TIFFs as a time series, the Image
Read Parameters dialog prompted for every single file when the All channels channel
conversion was selected.

Apply Button: Removal of a module with enabled Apply button did not disable the Apply
button. Pushing the button in this state caused an error and/or a crash.

Saving Surfaces: In Pack&Go networks or with the auto-save feature Amira tried to save
surface objects in Matlab m-file format.

Networks: Reloading a network containing a selected colormap object could crash Amira.
Time Series: When a time series was loaded, removed and loaded again, some time steps
had wrong channel names, e.g. *_ch3, *_ch4 instead of *_ch1, *_ch2.

Tcl Console: Command clear typed in the console brought the next line into a
unresponsive state. Backspacing or using arrow keys did no longer work. Anything could

be entered without any effect.



Changes since Amira 5.0.1

Amira Standard Edition

Multi Planar Viewer

The new Multi Planar Viewer is a special purpose sub-application for visualizing and exploring up

to two data sets simultaneously using three Multi-Planar Reformat (MPR) viewers and one 3D

viewer showing the data set(s) as volume rendering(s). The visualized volumes cannot only be

explored and compared, but they can also be aligned and registered using integrated tools. This

viewer is dedicated explicitly to users in biomedical research who need to visually explore and/or

register image data with a few clicks in an easy-to-use and high quality visualization framework.

The Multi Planar Viewer is part of the Amira Standard Edition.

New Display Modules

New Annotatedlsoline display module. Displays isolines with annotations on 3D scalar
fields.

New BumpsSilice display module. Displays orthogonal slices with embossed mapping on
any regular scalar field.

New CityPlot display module. This module displays a scalar data field as a 3D histogram.
New DisplayDate display module. This module displays the date.

New ClusterStringLabels display module. This module visualizes string labels associated

with data objects of type Cluster.

Readers

New SWC reader and writer for neuroscience — The new Duke-Southampton SWC reader
and writer for neuronal morphology supports the import and export in SWC format. This
format can be used, for example, with the cvapp application allowing the conversion
between various neuron morphology formats.

Added support for 1-bit TIFF images.

New Tridelity Module for Autostereoscopic Display

New module TridelityView allows the main Amira viewer to be displayed in the following

autostereoscopic displays: Tridelity Multi-View 19”, 27", 42", and 57".

Help and Documentation

The search algorithm is now faster.



e New fonts are now used to improve the readability.

o The list of the demos has been slightly reorganized, a new Deconvolution demo has been
added, and the Multichannel and Align demos have been moved from the ResolveRT
section Amira.

¢ A help button has been added to all data objects in the Properties area. It is now easier to
learn about the data type.

e The documentation for the modules Trajectory (Amira) and SpatialGraphStatistics (Amira)
has been added.

¢ The documentation of several modules has been updated.

e The tutorial “Visualization of Vector Fields” has been adapted to Life Science.: the results
of a blood flow simulation are used instead of the “wing” data sets; the tutorial has been

also modified according to the new data sets characteristics.

Improved user interface of the measurement tool

The handling of the measurement tool has been reworked so that the Add button has become
obsolete. The tool is activated by clicking the button in the viewer tool bar. When active, clicking in
the viewer creates and modifies measurements or annotations. Therefore, click at a new position
in the viewer to add a measurement or annotation and click on one of its ends to edit it. The ESC
key toggles between measurement and the currently selected viewer navigation (default:
trackball). To terminate measurement mode select Interact (arrow) from the viewer toolbar.

Thus, the tool can be now used within sub-applications (Segmentation Editor, Filament Editor), but

the Properties of Measurement are not accessible.

Spin Animation
Spin animation is again ON by default. To enable/disable it, use the viewer context menu,
Preferences->Spin animation. Unlike in Amira 5.0.1, the state is remembered for the next Amira

session.

Trajectory
Module Trajectory can be used to steer an ObliqueSlice along a LineSet data object. Now the
module can be also attached to SpatialGraph objects, which are the result of skeletonization or

tracing using the Filament Editor or the tools of the Skeleton Option.

Volren

Added support for a wide range of graphics boards (see System Requirements).



SurfaceView

The 8 radio buttons of port Colors have been redesigned to a pull-down menu with 8 entries.

Unicode Support in Annotation module
The Annotation module now supports Unicode character strings allowing correct display in any

language and character set.

Image Filtering Improvements
¢ New: FilteredObliqueSlice module which applies filters and visualizes data from an
arbitrary slice.
e Image filters have been renamed using more explicit names.

e All 3D image filters have now a 2D equivalent filter.

ObliqueSlice
In port Sampling: there is a new option to set a user-defined sampling matrix.

DemoMaker
The DemoMaker script has been improved for handling complex sequences:
e Search in event list.
¢ Save and load a file containing the event list, using internal format. In some cases, it can

be convenient to export, import or edit this event list file.

Amira for Microscopy (ResolveRT)
Filament Editor
The user interface of the Filament Editor has been improved:
¢ In order to facilitate the use of the tools, only two tabs are now available in the tool box, the
View Options and the Tools tabs.
o The Autoskeleton Options and the graph analysis tools have been reorganized in the Tools
tab.
e A new icon has been added to the toolbar to activate the tracer, while the tracing options
have been moved into the Tools tab.
o The Preview option toggle has been removed. Instead, there is now a button next to the
Window Level slider similar to the Segmentation Editor. When the button is pressed, the
Alpha slider is available below the Window Level slider.
e The Show Thick Slice toggle has been removed from the tool box. The functionality is now

available as a button next to the Thickness slider.



File Readers
¢ New Olympus OIB/OIF readers for images acquired with Olympus confocal microscopes of
the FluoView 1000 generation.
e Several problems have been fixed in the Leica LIF and Zeiss LSM readers. Amira now also

supports 12-bit encoded LIF data.

Very Large Data Option
New Display Modules
The new interpolation type (“multi-samples”) on LDA ortho and oblique slices provides much
higher quality images than linear interpolation.
¢ ArithmeticRendering: arbitrary arithmetic according to a user-defined arithmetic expression
of up to three inputs according to a user-defined arithmetic expression.

e CastLattice: changes or converts the primitive data type of out-of-core data.

OrthoSlice and ObliqueSlice
The new interpolation type (“multi-samples”) on LDA ortho and oblique slices provides much

higher quality images than linear interpolation.

Voltex (LDA)
The Voltex (LDA) module has been improved in quality and performance options:
e Edge coloring option — Enables to color edges based on the gradient direction.
o 2D edge detection option — A 2D edge detection algorithm is used to highlight edges of the
rendered volume image.
¢ Boundary opacity option — Increases the opacity of boundaries based on the magnitude of
the gradient.
¢ lllumination quality option — Provides different methods for computing the gradient (normal)
used when the rendering is lighted.
e Lessringing artifacts option to decrease slice edge artifacts when few slices are displayed.
e Cubic interpolation option to get a smooth rendering.
¢ New performance options — Different rendering techniques are available in order to

improve the performance.

LDA Conversion

New LDA conversion options on LDA data:
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Data compression means that the files use less disk space and can be loaded faster (fewer
bytes to move). Currently gzip and jpeg compressions are available. Gzip is the default.
Border size option allows you to avoid discontinuity artifacts. With lighted volume rendering
or with embossed mapped slices, a border size of 3 should be specified.

The above options are set via the LDA tab of the Edit->Preferences dialog.

Quantification+ Option

Graphical User Interface improvement providing better integration within the Amira
interface.

The performance of the binseparate morphologic tool has been improved.

Bug Fixes

LocalAxis: grid and text were displayed displaced.

SurfaceGen with auto-refresh checked did not recompute triangulation when the label field
was changed.

In module Resample the auto-refresh function did not work.

LabelVoxel Histogram: Curve color was reset when changing the threshold values with
slider.

Attempting to use Deconvolution on unsigned short data led to a crash. Deconvolution can
now handle unsigned short data.

Deconvolution did not use multiple cores or CPUs if they were present.

Amira did not start on a Windows 2000 system.

Whenever image data (uniform scalar fields) have a transformation matrix parameter and
an ApplyTransform was used, the parameter was not reset, so that when reloading the
data set the transformation was set again.

The Merge module was missing a background or padding value to be specified by the user.
This value is necessary, for example, when merging CT data where the background level
typically is smaller than 0. (already in 5.0)

The Adjust range function of PortColormap did not work with objects of type HxCluster,
HxNeuronTree, or HxSpatialGraph. This has been fixed. For multiple data defined on the
geometry Adjust range adjusts to the currently selected.

The Adjust range function of PortColormap did not work with objects of type
HxFEIUniformScalarField.
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AmiraMesh files that contained non-image data and exceeded the Out-of-Core threshold
opened the Out-of-Core conversion dialog although the data was not convertible. This has
been changed such that no dialog pops up for non-convertible AmiraMesh files.
In the Trajectory module the Up front option of port View was not working properly.
Arithmetic: if the result of an Arithmetic module was changed with respect to voxel size the
source data object assumed the same voxel size.
Segmentation Editor:

0 The data window could not be set numerically.

0 The 3D Lasso did not work correctly with an orthographic camera.

0 The 2D Lasso in fencing mode was not working correctly

o When a label field was created from within the Segmentation Editor, there was no

default material “Inside”.
o In 4-viewer mode with masking enabled it was possible to make a selection outside
the masked region.

0 The parameter DataWindow was not considered.

0 Sometimes the “Replace” function for selections did not work.
Export of MATLAB .mat files crashed Amira.
SurfaceGen always created a material Exterior2 even if the “Extra material” option was not
checked.
Fields of low dimensionality as input to module ChannelWorks caused a crash.
CreateSurface of SurfaceCut sometimes crashed.
Loading a RAW series where the files did not have the file extension .raw triggered the
display of the File Format dialog for every slice.
LineSet Editor: Attempting to connect two endpoints using the Data dependent option
caused Amira to crash if there was no scalar field in the Pool.
Createlmage of ObliqueSlice crashed on multichannel field data.
Batch processing did not work in Amira 5.
Volren crashed with RGBA color images.
The 2D Raw File reader presented the File Type dialog for every slice.
Transform Editor relative local rotation was incorrect.
Snapshot command with Volren rendered viewer gadgets with bad background.
ObligueSlice: With multichannel data it was not possible to switch individual channels on
and off.
AmiraDev — On Windows systems in the Start menu the item Amira --debug was missing.

Crash after deleting all items from the Pool at once.
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¢ Removing a VolPro1000 module crashed Amira.

e The state of some editor buttons was not updated correctly.

Known Issues
General

¢ RadiusHistogram — The documentation is missing in the Online Help.
e Isosurface (LDA) on FireGL V7350 does not render correctly.
e Voltex (LDA) on FireGL V7350 “Move low resolution” does not work. When checked, Amira
freezes.
¢ Volren on FireGL V7350 in mode Shaded (Diffuse, Specular), the shading effect does not
work properly.
Windows XP x64
e Using the DV Video Encoder in the MovieMaker module may cause an access violation.
This is a bug in Windows that can be fixed with the following hotfix:
http://support.microsoft.com/kb/943443. The hotfix requires SP2.
Mac OS X
e Splitter in the GUI — Double clicking on the splitters does not expand the window frames.
e Amira Icon — When Amira is installed, the red icon might not be shown in the Amira
installation directory. In this case please start the application by double clicking the script
“start” in the sub-directory /bin, which is located in the Amira installation directory.
e Stereo Mode —OpenGL stereo is not available.
Linux
e The fencing mode of the Brush tool in the Segmentation Editor does not work with Alt key
by default. In KDE the Alt key is used as the default meta key for window actions; therefore
the Alt key has to be disabled as the meta key in the KDE options in order to enable

fencing mode in Amira.

Changes since Amira 5.0
Bug fixes:
e Various fixes in Large Data Access / External Disk Data support.
¢ Fixed "Save Network" for multi-frame TIFF images.
o Fixed deleting the last channel of a MultiChannelField.
e Various fixes for the HxVolren module.

e Fixed some issues with the extra viewer.
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Changes since Amira 4.1.2

Improvements and new features for Amira
Sub-applications for improved workflow
Amira 5.0 introduces a new concept to optimize the workflow for particular tasks. Some editors,
the Pool, and the new Tree View are now “sub-applications”. Sub-applications substitute the
standard Pool/Properties layout of the main panel by a task specific and workflow-optimized user
interface. Also, each sub-application defines its own set of viewers that operate independently
from the standard Amira 3D viewer. A convenient sub-application task bar below the main menu
provides access to different sub-applications at any time by a single mouse click. The following
components are currently sub-applications:

¢ Object Pool

o Tree View

o Segmentation Editor

e Filament Editor

Further changes to the GUI

¢ The main panel hosting Pool and Properties has been moved to the left of the viewer
window. Users who prefer the right-hand main panel may configure this in the Edit-
>Preferences/Layout tab.

e Amira 5.0 is now based on Trolltech's Qt 4 library for the graphical user interface. Among
other improvements, this introduces the use of style sheets for the Amira skin. In the future,
Visage Imaging plans to add alternative skins to let the user have a personalized Amira.

¢ New floating tool bar concept in the viewer with new and re-designed icons.

o Tools in the viewer tool bar have been rearranged in independent groups which can be
moved freely to the sides of the viewer.

e Menu item File->Jobs has been moved to Edit->Dialogs

e Menu item Edit->Database has been moved to Edit->Dialogs

e The options Duplicate mode and Auto adjust range of colormaps have been added to the
Pool menu. If Duplicate mode is activated, the settings for new modules of the same type
attached to a particular data object are duplicated. If Auto adjust range of colormaps is
checked, the colormap range is automatically adjusted.

e Explorer — Explorer item is displayed if "Tree View" is selected. The Explorer menu is
identical to the Pool menu except that the Show, Show All, and Hide items are not

available.
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e New functionality on right-click context menu of selected objects: Hide, Remove, Duplicate,
Rename, Save, Save As

¢ New functionality on right-click context menu in Pool: Show Hidden Objects, Show All,
Remove All Objects, Save Network, Save Network As...

o Tree View: As an alternative to the Object Pool the Tree View offers the possibility to
represent data objects and modules in an explorer-like tree widget. Complex networks with
many icons can benefit from this representation by sorting modules according to their type
into different folders.

e The Tree View is implemented as a sub-application and can be invoked at any time from

the sub-application tool bar.

Volren

With Volren Amira 5.0 offers a completely new volume rendering module. The new module
features several rendering techniques such as classical emission/absorption volume rendering
(VRT) as well as shaded volume rendering (sVRT), maximum intensity projection (MIP), and
digitally reconstructed radiograph (DRR). The module supports the interactive rendering of even
large data sets by using a low-resolution-on-move rendering strategy. A “smart sampling”
technique guarantees rendering results free of slicing artifacts even for steep transfer functions
and close-up views. Together with Amira's label field concept, Volren enables the differential
rendering of user-defined regions of interest.

Note on hardware compatibility: Volren makes extensive use of the latest features of current
GPUs (Graphics Processing Units). Thus, some advanced features of Volren, in particular sVRT,
are available for recent graphics boards only. For NVIDIA products we support GPUs starting with
the NV40 (corresponds to GeForce 6xxx

series and Quadro 35xx models). For ATI's Radeon family of video cards support for advanced
volume rendering is expected for all boards of the X series. However we have seen incorrect
rendering with some combinations of drivers and video cards. ATI's FireGL V7350 is currently not
working with Amira's shaded volume rendering.

Known issues: When two or more Volren modules are used and rendering modes are mixed
across modules, rendering artifacts may occur. In the case of multivolume rendering the supported
combination of rendering modes are one MIP with one MIP and one VRT with one VRT. Other

modes and combinations may lead to incorrect rendering results.

Segmentation Editor

The Segmentation Editor has been reorganized using the sub-application concept. The user
interface has been improved:
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Data Selector: two drop-down menus let you select the image and label data to be edited.

The drop-down menu lists all compatible data objects in the Pool.

Material List: there are three new columns to turn on/off the 3D and 2D view for each

material and enable volume rendering in the material color.

Zoom and Data Window: A drop-down menu next to the range sliders lets you select a

color map for display in the 2D viewers.

Selection and Display: The 3D Lasso buttons have been replaced by Grow/Shrink buttons,

previously available in the Selection menu only. The 3D Lasso has been integrated with the

2D lasso in the Tool Box.

Display and Masking: this new group of controls offers buttons to enable 2D crosshairs, 3

orthogonal slice view, and 3D volume rendering.

A generalized masking concept has been added to most of the tools to specify an

applicable data range. The mask can be set through range sliders with histogram plot and

is displayed as a blue semi-transparent overlay in the 2D viewers.

Tool Box: the Propagating Front tool is no longer available; a new Threshold tool has been

added.

Changes in the menu bar:

0 Segmentation->Data Window has been removed. The windowing is now directly
possible using the range slider widget in the GUI. TissueStatistics has been renamed to
MaterialStatistics. Likewise, the corresponding module in the Pool ->Measure-
>TissueStatistics has been renamed to MaterialStatistics. Current Viewer has been
added to select the active viewer. Gray image and Gradient image have been removed
due to the new Image Data and Label Data selectors in the control panel.

0 Selection->Draw Style has been removed. It is now accessible through the context
menu in the Material list only. Active Contour has been removed completely. Threshold

has been moved from the Selection menu to the Tool Box with the masking option.

Readers/Writers

Nifti — Short for Neuroimaging Informatics Technology Initiative. File format based on the
popular Analyze7.5 format. Amira now reads and writes files in this format.

HOC - Hoc is a scripting language used by the NEURON simulation environment to
describe neurons and neuronal networks. Amira 5.0 features an import and export filter to
read and write the geometric and topologic information of spatial graph data objects.
Vevo 3D - File format used by the Vevo 770 ultrasound scanner. Amira 5.0 supports 3D

and 2D Power Doppler as well as 2D and 2D Power Doppler images in this format.
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AmiraMesh — Amira can now read data from the VisageWS™ and VisageCS™ products of

Visage Imaging.

Miscellaneous

CalculusMatlab — Now supported on Windows 64. Improved MATLAB engine connection.
The CalculusMatlab module now transfers all native Amira data types to MATLAB and
back. This improves the memory handling and allows users to work with larger data sets.
Note: A change in CalculusMatlab requires now a different order in the dimensional terms
of MATLAB data objects.

ConvertSpatialGraphToLineSet — Converts an HxSpatialGraph object to an object of type
HxLineSet.

ConvertLineSetToSpatialGraph — Converts an HxLineSet object to an HxSpatialGraph data
type.

CornerCut — This module defines a cutting region with the shape of an axis-aligned 3D box
originating from a corner of the bounding box.

Colormap Editor Alpha Curve — The Colormap Editor has been enhanced to allow editing
of the colormap alpha values using an alpha curve that you can shape interactively with the
mouse. Previously the alpha values could only be edited using "keys". This feature is
accessed via the Edit->Show Alpha Curve item of the Colormap Editor dialog. Unlike most
attribute settings in Amira, this setting is persistent across Amira sessions.

CollectiveTCL — This is a new module for executing a Tcl command on objects in the Pool.
You can specify that it be applied to all visible objects (i.e., not hidden), all selected objects,
or all objects of a specified type.

ExtractSurface — This module wraps the Draw Style->CreateSurface functionality of all
surface-like display modules (SurfaceView, GridVolume, HexaView) to create a separate
surface object from all visible triangles. Together with the auto-refresh option the module
allows to realize pipeline processing networks in the Pool.

ProjectionView — In order to restrict the projection to a sub-volume of the image data in
Amira 4.x a SelectRoi module could be connected to the data object. ProjectionView then
had to be connected to the SelectRoi module. This workflow seemed unnecessarily
tedious, so a restrict option has been added to ProjectionView. Also the performance of
ProjectionView on MultiChannelField objects has been improved.

SpatialGraph — A data class to store data organized in three dimensional networks has
been added.

SpatialGraphView — This module visualizes data objects of type SpatialGraph.
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SpatialGraphStatistics — A compute module to calculate and show quantitative information
for segments of a SpatialGraph object.
PlotSpreadSheet — Some modules, such as MaterialStatistics, create a spreadsheet of
values. The new PlotSpreadSheet module allows you to display the values as a plot in a
separate window. You can select a single column of data to be used for the X axis values,
and one or more columns to be plotted on the Y axis.
ViewerPlot — Some modules, such as Histogram and LineProbe, create a plot in a separate
window. The new ViewerPlot module lets you to display the plot within the viewer window.
You can control the placement, size, transparency, and other attributes of the plot within
the viewer.
Demo Framework — The Demo Framework is a set of utilities for organizing multiple
demos. It incorporates four major parts
o A directory and file structure containing the Amira scripts to execute the demos,
their description, and their data. The directory structure may realize a grouping and
can also resemble a project structure of the demos.
0 Several scripts to select demos from the demo collection, utilities to download data
from remote servers, helper scripts for demo steering, etc.
o Demo GUI, an editor for conveniently selecting and changing demo collections.
o DemoSequence, an Amira script object for driving the selected demos.
License manager — The license manager dialog has been completely redesigned. It is now
possible to edit the current license file in the manager dialog, or to drag text files containing
license keys into the dialog directly. Also, license keys are checked for validity on-the-fly
and are printed green when they are valid and red when they are invalid.
By popular demand, spin animation is now OFF by default. To enable/disable it, use the
viewer context menu, Preferences->Spin animation.
A viewer gnomon (compass) is now available. Use Preferences->Layout, Viewer Gadgets
to control the display, position, and appearance of the gnomon.
SurfaceView: Has an expanded set of options in its Color port.
Surface Editor: The selection tools are now more easily accessible, each one having its
own button on the tool bar. Previously they were in a drop-down menu.
Pool: Now you can display the input ports in the Pool view. This is set via Preferences-
>Layout, Pool.
The Preferences->LDA tab has been modified slightly. The Out-of-core threshold item was

relabeled Conversion. Compression, Tile size, and Border size are new items.
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New Preferences->Rendering tab. Specifically shadow casting can now be enabled. If
enabled, shadowing can be controlled on a per-module basis via an icon in its control
panel.

New: direct access to help for data objects. That is, green data objects now have a "?"
button in the Properties Area to go directly to the help page for their data type.
Licensing enhancement: Lack of an AmiraDev license when the Developer Pack is
installed no longer prevents basic Amira from running.

Due to frequent issues with OpenGL drivers the View->Easy Fade removed.

Improvements and new features in Amira for Microscopy (ResolveRT)

Filament Editor

The Filament Editor is a completely new sub-application designed to analyze and

quantify 3D images of filamentous structures such as neurons and blood vessel

networks.

It features automatic and interactive tracing tools and convenient viewing of the image

data and extracted graph data in a pair of MPR and 3D viewer. Refer to the User's

Guide for more information

Readers/Writers

Leica LIF reader: Support for Version 2, supports now multichannel time series and save
network.

Zeiss LSM reader: Many LSM files were read without voxel size information. This has been
fixed and in addition the reader evaluates the meta information contained in LSM files and

writes it into a parameter bundle Zeiss_LSM of the Amira object.

Improvements and new features in Amira DICOM Reader

DicomSend — New module to send all slices of an HxUniformScalarField3 to a remote
DICOM node.

Improvements and new features in Amira Mesh Pack

¢ _GenerateGradients — This module allows one to compute artificial gradient weighted

images from DTI tensor fields. A gradient direction is specified and the gradient weighted

volume can be created with either floating point resolution or in 16bit.

Improvements and new features in Amira Mol

MolView — Size of highlighting is now adjustable.

¢ _ RankTimeSteps — Added option to compute rmsd based on selected atoms only.
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Improvements and new features in Amira Quantification Pack
e Added support for Win64.

Improvements and new features in Amira Skeleton Pack
¢ All modules now support objects of type HxSpatialGraph

Bug fixes
Unless otherwise indicated, the bugs listed below have been fixed such that the
behavior described is no longer encountered.

Amira
¢ LineProbe crashed when re-connected to another lineset object.

e Regular vector fields could not be saved as AmiraMesh ASCII format.
e Qut-of-core threshold setting (Edit->Preferences->LDA) was ignored when loading files via
drag-and-drop.
¢ Endianess (byte order) handling has been fixed for several modules.
e Utility docZ2html, used to create custom documentation, has been fixed and improved.
e LineSetView: a message from port Spheres had wrong characters.
e Colormap Editor: several bugs fixed.
e _ Segmentation Editor:
o0 Wrong selection when using Magic Wand tool,
o0 The Blow tool sometimes did not highlight correctly with the crosshair enabled.
0 Snake tool up/down was not working properly.
e Fluent file export is now compatible with Fluent 6.1.22.
o DICOM export: Fixed date conversion bug.
e DisplayDate was not working correctly.
e MultiChannelField: Save network has been fixed. Save method of multichannel has been
improved.
e SurfaceView draw tool did not consider transformation in selectVisibleOnly mode.
e The image filters compute modules did not preserve the parameter section in the result
object.

Amira Molecular Pack
¢ GROMACS file reader: fixed GROMACS format check.

¢ HBondView, MolView: fixed crash when no cylinders are displayed, fixed memory leak.
e _ CompMolinterface: fixed crash on 64-bit systems.
Amira Mesh Pack

20



e _ AVS reader: There was an invalid default bounding box when this information was missing
in the AVS header file.
e GridToSurface: Documentation has been added.

Amira Skeleton Pack
e Documentation easier to access: link added to home page of help browser.

Amira Very Large Data Pack
o Documentation for CastLattice was missing.

Changes since Amira 4.1

Improvements and new features:
e _ Preliminary support for the Leica LIF file format has been added. Limitations:
0 No support for time series data within a LIF file. Currently the first
image/multichannel image of a series will be loaded.
o0 No direct support for the "Save Network" functionality of Amira. Image data must be
saved first as, e.g. AmiraMesh, before a network can be saved.
e The FiberTracking module now contains a new setting that allows for a better initialization
of the seed points of the fiber tracking.
e For MRC files with extended header information as defined by the FEI company, the reader
will display the resolution of the data in nm (nanometers) if the extended header section
contains this information. The MRC writer will now export existing extended header

information into the exported MRC file.

Bug fixes:
Unless otherwise indicated, the bugs listed below have been fixed such that the
behavior described is no longer encountered.
¢ OrthoSlice was in the right-mouse menu of HxUniformVectorfield3.
e Networks with long paths were not restored.
¢ Calling the Normalizelmage module caused an error message: Bad type
'HxNormalizelmage'.
¢ File AMIRA _ROOT/data/registration/MRT-data.am was corrupted.
¢ _In both the Segmentation Editor and StandardView making a snapshot caused a crash
when one of the 2D viewers was active.
¢ Min and max values of colormaps were not correctly saved/restored in networks.
e After saving a new network, the File dialog behaved oddly. Selecting a file name in the

browser did not deselect a previous selection.
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e _With the CurvedSlice module, all visualizations in the viewer disappeared when the user
attempted to edit the curve object.

e Transformations of LDA objects were not displayed correctly.

e There was a program crash on the attempt to convert raw data containing double precision
floats to LDA.

¢ _In VolumeEdit there was a program crash when clicking "Undo" while working with non-
byte image data.

e Converting float fields with Big Endian byte order to LDA failed.

e There was a program crash on the attempt to reconnect an OrthoSlice from an LDA object
to a field with double precision floats.

¢ When OrthoSlice/ObliqueSlice were attached to an LDA object the Data Window was
always set to "0 .. 255" independent of the actual data range. Now the data window will be
set to the minimum and maximum of the data.

¢ _ AlignSlices editor: Translating slices with the arrow keys did not work.

¢ _AlignSilices editor: The parameters for the Least Squares algorithm stored in the ->Align-
>Options dialog were not saved correctly.

e When editing image stacks with few slices in the Segmentation Editor the slice slider in the
Xy viewer could not be moved. Instead, depending on the active tool, a selection was
made.

e DisplayTime was not displayed in Viewer 0 when a CameraPath editor was opened. It was
only displayed in Viewer 5.

¢  On SGI PRISM Amira crashed with anti-aliased rendering.

e _ On Linux the installer failed to launch without root permissions.

o Custom I/0O modules were not registered in the resource file.

¢ _The file benzene.hx was not properly displayed in Amira 4.1.

¢ _In the DemoMaker one had to click on the play button twice after the first time.

e _ Attaching a script file to a Mosaic of the Skeleton pack caused a crash.

e _Editing a colormap in multichannel mode caused a crash.

e LDA conversion of AmiraMesh files without the .am extension was not correct.

Changes since Amira 4.0

Changes in Amira standard
¢ Segmentation editor enhancement adding support for short, int, and float data types.
e Colormap support for multi-channel data. A colormap can be now specified for each

channel.
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The default colors for multi-channel data are now blue/green/red (previously
red/green/blue). This change is for consistency with the coloring conventions used by
biologists and other scientists.

New module Normalizelmage allows you to remove non-uniform illumination from image
stacks.

New 3D camera trackball for constrained rotation of the camera around the screen-aligned
X, Y, and Z axes. The visibility (on, off, autohide) of the trackball icon is controlled via the
Preferences dialog.

AlignSlices module has been modified:

0 Itis now possible to use maximum intensity projections of a number (n) of slices
instead of the image data for the reference image and the transformed image. This
is particularly helpful when aligning very small (point-like) objects, e.g., cross
sections of neurons. The following scripting commands are added:
setUseMaxIntProjection [0]|1], setMaxIntProjectionRefThickness [number_of_slices],
and setMaxIntProjectionSliceThickness [number_of_slices].

o "get" commands have been added for each of the existing "set" commands.

New colormap context menu item "Adjust range" to automatically adjust the colormap
range to the connected data range.

"Select All" option in open file dialog boxes with the shortcut key .

. "Select All" option in the Edit menu. This applies to objects in the Pool.

Macrovision FLEXnet support. In addition to the existing licensing module, Macrovision
FLEXnet Publisher Licensing Module is used for floating (concurrent) license usage. The
files for this support are provided in the share/license/flexnet directory.

Includes all patches for Amira 4.0 and many more bug fixes.

Changes in Amira Large Data Pack

Emboss mapping on LDA ortho and oblique slices. This rendering technique (also known
as "bump mapping") emphasizes gradient changes in the data on the slice. NOTE:

Requires programmable shader support in the graphics hardware.

. Isosurface rendering. With this module, Isosurface LDA, isosurfaces are computed in the

GPU, not the CPU. The threshold can be changed interactively and applied to very large
data sets. NOTE: Requires programmable shader support in the graphics hardware.
Interactive lighting on volume rendering (Voltex). Produces high quality visual results.

NOTE: Requires programmable shader support in the graphics hardware.

. High quality volume rendering (Voltex). This technique is useful because it usually provides

much higher image quality for the same number of slices. It is also useful when the
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The three data probing modules -- PointProbe, LineProbe, and SplineProbe -- can be used
with LDA (Large Data Access, described below in the 4.0 Release Notes) data to inspect

your very large data sets.

. Multi-channel support with LDA data.

. New LDA preferences in order to easily adjust the rendering quality according to the

capabilities of your hardware. See the Preferences dialog.

. New LDA expert setting module (LDAExpertSettings) to tune all LDA options.

Changes in Amira Mesh Pack

. A FiberTracking module was added which implements the traceline algorithm (STT and

TEND). This is useful for working with tensor fields.

The documentation of the ComputeTensorOutOfCore module was updated to illustrate its
intended use better.

A ComputeTensor module which works with already loaded volumes was added.

A new demo is provided to show tensor display capabilities (available from the on-line help
file).

The Meshsize parameter of TetraGen can now be set arbitrarily. Previously it was
restricted to a maximum of 3 times or a minimum of 1/3 of the average edge length of the

input surface.

Changes in Amira Molecular Pack

New Module: MolElectrostatics Allows computing the electrostatic or potential field of an
atomic or surface charge distribution in a homogeneous dielectric on a surface or a lattice.
Molecular Editor improved. Allows adding/removing bonds and atoms, changing atomic
numbers and bonds orders, with automatic adaption of hydrogens and atom geometry.
Adding rings, chains or molecular groups defined by SMILES strings. Assignment of
implicit hydrogens, formal charges, adding/removing hydrogens removing crystallographic
water, assigning Kekule structures or assigning aromaticity to rings. Local force field
minimization of structure.

New Module: PseudoElectronDensity Computes a scalar density field by accumulating the
per-atom electron densities of the molecule, which are approximated by Gaussian blobs.

The computed pseudo electron density may be used for superposing an experimentally
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Changes in Amira ResolveRT Microscopy Pack

o The application icon name, icon bitmap, and window banner have been changed to say
Amira instead of ResolveRT.
e The MRC file format reader now displays a dialog box where the user can specify to either

convert the data to VolumeViz LDM, to the ExternalDiskData format, or to read in the data

natively.

Changes in Amira Quantification+ Pack

e Several tutorials were added to help you get acquainted with the features and usage of the
Quantification+ Pack. Click on the Quantification+ Pack link on the home page of the Amira

help browser.

Changes since Amira 3.1.1

New in Amira standard

e The Amira product suite has been reorganized into two product lines to better serve

customer needs:
o Amira 4.0 standard

o ResolveRT: Amira for microscopy, including support for deconvolution, multi-
channel data, slice alignment, and readers for microscopy formats (Leica, Analyze,
Bio-Rad, stacked slices).

Amira "packs" are additional sets of modules providing solutions for dedicated application
areas. Packs can be added to a standard Amira installation at any time. For each pack a

separate license is required. The following packs are available:

o Amira Large Data Pack: visualizing and accessing large volume data sets up to

8GB not fitting in memory

o Amira Very Large Data Pack: visualizing and accessing large volume data sets

larger than 8GB not fitting in memory and up to hundreds of GB.
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o Amira Quantification+ Pack: more features for advanced quantification and analysis
o Amira Mesh Pack: modules for pre/post-processing of 2D and 3D meshes

o Amira Molecular Pack: molecular visualization, editing, alignment

o Amira Developer Pack: toolkit with C++ API for extending and customizing Amira

o Amira VR Pack: for VR systems, immersion, 3D interaction, multi-pipe, clusters

o Amira CAD readers: optional imports for CAD geometry formats: CATIA 4, CATIA
5, IGES, STEP

o Amira CAE readers: optional imports for CAE simulation results: Radioss,
MADYMO

o Amira Dicom reader: advanced parameter editor, pre-view and reader for DICOM

file format
o Amira SEG-Y reader: advanced reader for SEG-Y seismic data format

o ResolveRT Skeletonization Pack: skeletonization with large data support

Revamped user interface: A unique window now gathers panels for pool, viewers, help and
console, yet layout preferences allow switching back to top-level windows instead of
panels. The viewer's buttons have moved to a toolbar. Shortcuts to most frequently used
modules appear in a bar above the network pool. Sub-networks can be
collapsed/expanded with -/+ button in the module icon. Other enhancements include direct
network panning and deleting modules by drag & drop over a trashcan. The former "dolt"
button with a red toggle is superseded by an "Apply" button and an "auto-refresh" check
box at the bottom of module's properties panel. The segmentation editor, slice aligner, and
surface editor have a unified interface (viewer, top menu bar). The segmentation editor
panel can be switched with the pool panel via a tab button. Medical or technical naming
convention can be chosen for orientations (in layout preferences). Preferences settings are

gathered in a single place (menu Edit/Preferences).
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New colormap editor: Simplified settings. The histogram is displayed in background.
Grayscale mode. The former colormap editor is available as the "Advanced Color Editor". A

new predefined colormap is available (seismic.col).

Enhanced support for large data sets under 64-bit: Now all places in Amira array indices
are computed using 64-bit integers. Therefore data sets with at most 2231 elements can be
processed. In order to support 8-bit data sets larger than 2 GB or 16-bit data larger than 4

GB, all loops have been revised and 64-bit integers have been used for indexing

New MATLAB support: New reader and writer for MATLAB .mat file format. New module
CalculusMatlab allows you to load, edit, and execute MATLAB scripts directly from Amira,
by connecting directly to MATLAB server: input objects are accessible as MATLAB
matrices, and results are put in the Amira pool. This module allows using Amira as an

advanced MATLAB toolbox for 3D data analysis and visualization.
New image filter: Gamma-Correction.

Enhanced OrthoSlice and ObliqueSlice modules: Now support large data with high
resolution: subdivision into multiple textures is automatically done if needed to overcome

maximum texture size supported on the graphics cards.

Enhanced ObliqueSlice: A slice can be fitted to a set of points that can be specified by
clicking somewhere on visible geometry (slice, surface). For this, the option "fit to points"
must be activated. At least 3 points must be specified to position the slice. Giving more
points fits the slice into the point set via orthonormal regression. After deactivation of this
option, the slice can be positioned along its normal direction using the slider or rotated as

usual.

New module CurvedSlice: the CurvedSlice module lets you display arbitrarily curved slices

through a 3D scalar field or along a curve for 2D ones (fence display).
New module CylinderSlice: Displays the values of a scalar field on a cylinder.

New module SelectLines: Extracts a subset of lines or line segments from a given line set
object. You can select the subset by specifying regions of interest, an arithmetic

expression, or a label field.

Registration module label is renamed AffineRegistration (class name was already

HxAffineRegistration).
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Enhanced Segmentation editor: Interpolation is now possible between selections in
multiple slices. TissueStatistics can now be obtained directly from the segmentation menu.

Easier setting of the data window with histogram.

Enhanced TissueStatistics module: New option CumulativeSum for cumulative sum of the
values of the field in a particular region. New option to get area per slice. New port to
specify automatic detection of center of mass with Polar moment of inertia option. Notice

that TissueStatistics can now be obtained directly from the segmentation editor.
Enhanced Histogram module: New ROI input port added for handling Region Of Interest.

Enhanced SurfaceGen: A hidden menu is available that allows the creation of surfaces per
material without the need of changing the labels. Type "SurfaceGen showMaterialList" for

displaying the material selection list.

Enhanced IvToSurface: Diffuse colors in Open Inventor or VRML files can be read into

color vector field. Such field can then be used as colorfield input for SurfaceView.

Enhanced SurfaceDisplay: A new option has been added that allows selection via "draw"
acting on visible triangles only. This option can be set or unset with the command

"DisplaySurface selectVisibleOnly" 1 or 0.

Enhanced SurfaceDistance: The surface distance can be computed for a region of interest
only. Therefore, define an ROI for an object and connect it to the ROl input port of

SurfaceDistance.
Enhanced DXF write: .dxf files are now saved as version R11 files.
Enhanced CuttingPlane: Added port for translating the plane explicitly (allows animation).

Enhanced Measuring tool: 2D tools (line, angle, text) that work anywhere in the viewer
window, not just on geometry, are now available. It's now possible to control the font size of
the tool. It's also possible to control the display format of numeric values. The GUI has
been improved -- icons for controlling visibility, locking, and render-in-front are always

visible.

Enhanced SurfaceEditor: Now contains a number of new tools in the Surface/Edit menu
including: a tool for repair of intersections, a tool for fixing small dihedral angles, a tool for

fixing tetra quality, and a tool for preparation of tetrahedron generation which combines
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Enhanced SurfaceField data objects: Added new Tcl command "setEncoding”. Data values

are averaged if encoding is changed from OnNodes to OnTriangles.

Enhanced Resample module: Now capable of handling fields with up to six components,

like the complex vector type.

ChannelWorks and Arithmetic modules both support surface fields. Arithmetic supports

tensor fields as well.

Enhanced support for Cluster data objects (point sets):. New module ClusterLabel for
displaying text labels with point cluster. Reader extended for label support. New module

CreateCluster to create an empty cluster.

Enhanced Delaunay2D module: New faster algorithm for triangulation. New spherical
projection mode. New port for changing projection center. The former algorithm can be

selected with Tcl command "setTriangulator”.
Improved PointWrap: now considering transformations of the data.

New Tcl pick callbacks: New Tcl commands on modules and viewers which can be used to
register a Tcl procedure to be called whenever some pick event occurs with mouse or VR
input device. The triggered callback can retrieve information about picked object
coordinates, object, and possibly additional information provided by Amira modules

VertexView, ClusterView, SurfaceView, GridVolume, and GridBoundary.

DemoMaker enhancements: Added support for port ButtonMenu, more viewer commands,
waiting screen. New function jump allows the user to jump to an arbitrary breakpoint.
Added function writeDescriptionFile to generate description.xml files for Amira demos to

start with. Added auxiliary port descriptionFileName which is always hidden.

Animate module: added support for ports whose owner is an editor. Added Tcl method to

set maximum range from chosen port to time port
New module Sound for playing audio files (in menu Create>Animation/Demo).

Improved Isosurface performance.
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Many bug fixes and minor improvements, performance optimization including faster

memory operations and reduced memory consumption.

Enhanced module AlignSlices (slice aligner): Now allows for displaying orthogonal views
(coronal and sagittal) of the aligned image stack. The automatic least squares alignment
method now supports masking. The following scripting commands are added:
showCoronalView [0|1], showSagittalView [0|1], orthoViewZoomlIn, orthoViewZoomOut,

setSagittalViewSliceNumber [value], setCoronalViewSliceNumber [value].

New Amira Large Data Pack

New Large Data pack: New pack for Amira for LDA format support (Large Data Access)
enabling interactive visualization of datasets that can't be loaded fully in memory ("out-of-
core"). Based on the VolumeViz LDM technology from Mercury, the multi-resolution LDA
format and associated support modules are designed to allow interactive visualization and
roaming possibly with extremely large data (hundreds of GB), even on relatively low-end
machines. The LDA-aware visualization modules support progressive visualization of multi-

resolution volume data, asynchronously loaded from disk.

With Large Data Pack option, when loading volume files larger than a user-defined size in
preferences, the data can be converted to LDA multiresolution format, paged from disk or
loaded in memory when possible. Conversion to LDA format can be applied to original data
using the following formats: AmiraMesh, RawData, and StackedSlices (stacks of SGI,
TIFF, GIF, JPEG, BMP, PNG, JPEG2000, PGX, PNM, and RAS raster files) and SEG-Y.
The conversion process creates a new file and doesn't delete original data set. The Large
Data Pack allows converting or reading data up to 8GB. A Very Large Data option is

available for converting or reading data above 8GB.
LDA-aware modules can be directly connected to LDA data. Other modules can be
connected through using the new LatticeAccess module in order to extract a region (sub-

block), possibly sub-sampled, that can fit in memory.

LDA supersedes the former LDD format (LargeDiskData), still supported through

ConvertToLargeDiskData and Access modules.

The Large Data Pack comes with two options, one for data up to 8GB, and one for data

over 8GB. For data sets smaller than 1GB, a Large Data Pack license is not necessary.

30



e New LatticeAccess module: This module can be attached to Amira data objects providing a
Lattice interface. The Lattice interface is designed to access large data sets in a block-by-
block fashion on different resolution levels. Many Amira modules require data sets to be
stored completely in memory. The LatticeAccess modules makes it possible to use such

modules by converting a sub-block of a large volume into a memory-resident data object.

e New LDA file format: This is the native VolumeViz LDM file format for storing hierarchical
multi-resolution volume data, defined by Mercury. Data can be stored in a standalone file

(.Ida) or associated with a .dat file. In the latter case the .Ida file refers to the .dat file.
o New VolumeData data type for supporting Large Data Access

e New module ObliqueSlice (LDA) for Large Data: visualizes 3D image or scalar data on an

arbitrary slice

o New module OrthoSlice (LDA) for Large Data: visualizes 3D image or scalar data on an

orthogonal slice
o New module SelectRoi (LDA) for Large Data: defines a 3D region-of-interest

e New module Voltex (LDA) for Large Data: texture-based direct volume rendering of 3D

images
e Access module for LargeDiskData (LDD): loads a block from a LargeDiskData object

e ConvertToLargeDiskData module (LDD): converts raw data and stacks of image data to

LargeDiskData
Changes in ResolveRT, Amira for microscopy

e New module DataPreprocess: used to apply both a background and a flatfield correction to

a raw 3D image stack

o New reader for Interfile file format, used for exchange of nuclear medicine image data.

Data sets are separated into header files (.HDR) and data files (.IMG).
e Improved reader for Analyze file format, for robustness with noncompliant files.

e Analyze 7.5 files can now be exported. (Previously, this format was for import only.)
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e New reader/writer for MRC file format, used for exchange of electron microscopy data.

Recognized file extensions for the reader are .mrc and .rec.
New ResolveRT Skeleton Pack

o New module ApplyMask: This module can be used to segment a LargeDiskData file block
by block. It allows you to apply a mask to the LargeDiskData file in order to remove or add

parts.

e New module ApplyTemplateToMosaic: Script object to apply compute module or filter to all

bricks of a mosaic

e New module ChamferMap: performs a distance-map calculation on a 3D segmented

LargeDiskData image.
e New module DisplayMosaic: displays the bricks of a Mosaic.
e New module TracelLines: generates a LineSet from a thinned labelfield.

o New module CheckNetwork: The module detects open ends and branching points with
more than 3 branches in an attached Lineset. It sorts these points and moves a SelectRoi
object to be centered at one point after another. The point is highlighted by a red semi-

transparent sphere.

e New module EvalOnLines: The module takes a LineSet and a LargeDiskData field as input.

The field is evaluated at each vertex of the lineset and the result stored in the lineset
e New module Mosaic: A data class used to represent overlapping external data objects
e New module DistanceMap: computes a 3D distance field from a binary image.
e New module Thinner: Skeletonization of LargeDiskData objects by thinning

o New module AlignBlocks: If the bricks of a Mosaic were not perfectly aligned during data
acquisition, this module can be used to compute the best adjustment between overlapping

bricks.

o New module MosaicTolLargeDiskData: This module takes a Mosaic containing bricks of

overlapping image data and converts them to one LargeDiskData object stored on disk.

Changes in Amira Molecular Pack (Formerly AmiraMol)
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e Enhanced Molecule Selection Browser. Added color management: the current colors used
in all visualization modules are displayed for each group; user-defined colors can be set
and modified; clicking on a color pops up the color editor allowing the user to change the
group color; right-clicking a color further allows the user to change the color of all or only
the currently highlighted groups. Introduced sorting of groups: groups can now get sorted
according to name, index, type, etc; new icons in the Highlighting section, which allow a

much thinner representation of the selection browser.

e Enhanced CompMolinterface (Computation of molecular interfaces): No longer restricted to

levels with fewer than 257 groups. A level can now have up to 65536 groups.

e New module ComputeHBonds (Computation of H-bonds): Computes H-bonds and writes

them to the molecule's topology, which allows their saving (in ZMF format only).

e Enhanced MoleculeView: The cylinders can now have a cap. Two caps are possible: flat or
hemispherical. Hemispherical cap gives a much nicer visualization if only cylinders are

displayed.

e New module HBondView (On-the-fly visualization of H-bonds): If no H-bond level is present

in the molecule's topology, the H-bonds are computed on-the-fly in the HBondView module.

e New module ComputeSecondaryStructure (Computation of secondary structures):
Implementation of the DSSP algorithm by Kabsch and Sander. Secondary structures are

saved in the molecule's topology, which allows saving of the secondary structures.

e Enhanced module PrecomputedAlignments: Can now also be written and read. This is

interesting for the alignment of trajectories.
e New reader for GROMACS File Format.

e Enhanced MolTrajectory data objects (Molecular Observables): It is now possible to set
per-timestep as well as per-trajectory bbservables for a molecular trajectory with the Tcl
command "set{Int|Float}Observable &ltobservableName> &ltvalue> &lttimeStep>". If
&lttimeStep> is omitted or set to -1, a constant observable, i.e., a trajectory observable is

assumed. New observables can only be saved with the ZMF format.

Changes in Amira Mesh Pack
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New PolyhedralGrid data type for extended grid support: unstructured grid type supporting
mixed tetrahedron, hexahedron, pentahedron, and pyramid cells (based on the Open
Inventor MeshViz package). When reading finite-element or CFD data using, for instance,
the Fluent reader, conversion to tetrahedrons is no longer necessary, therefore allowing

much larger meshes to be handled.
New reader for Tecplot ASCII and Binary files. See documentation for description.

Enhanced and changed Gradient module. It can now handle rectilinear and curvilinear

scalar fields as well. This module now has an "apply" button

Enhanced AlignSurfaces: New port for choosing transformation type: rigid, rigid+uniform

scale, affine. New input port ROI for surface alignment based on region of interest.
Enhanced Shear module with automatic shear angle extraction from DICOM data.

New module TensorDisplay: This module displays symmetric second order tensors by
tensor glyphs. You can select either a sphere, a cylinder, a cone, or three lines to indicate

the tensor shape in a slice through the volume.

New module TensorField: Generates some standard analytical symmetric second order

tensor fields. You can use the Arithmetic module to sample the tensors on a uniform grid.

New module ComputeTensorOutOfCore: This module computes a symmetric second order
(diffusion) tensor from a set of N (N>=7) diffusion weighted images. The images must be
available on disk as AmiraMesh files and will be loaded by this module using Amira's
LargeDiskData format, which can handle data sizes above the maximum size of available

main memory.

New module ExtractEigenvalues: Extracts the eigenvalues from a symmetric tensor of

second order.

New module RateOfStrainTensor: This module computes the rate of strain tensor for a

given displacement vector field.

New module ParticlePlot: This module displays a vector field with particle animation similar
to the ConePlot module. The seed points for the particle traces can be distributed similar to
the distribution modes available in DisplaylSL. For thresholding, you can enter a
mathematical expression evaluated on the magnitude of the input vector field. A Runge

Kutta method (third order) is used for propagating the particles. A sample network is
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o TetraGrid data objects: Tcl interface for volume calculation added. Material access via

index changed for getVolume.

e The module PlanarLIC now allows you to control the generation of the noise pattern. This
is done using a new input field denoted as "seed". A value of 0 means that a different
random noise pattern is used for each successive calculation. Any other value allows you
to use the same noise pattern each time a computation is started. The latter yields better

results for videos where the LIC plane slices through a volume.

e Enhanced TetraGen: New Tcl method "setMaxDiamRatio". The diameter ratio of the
circumscribed and inscribed spheres is a quality measure for tetrahedra. By default, the
upper bound is set to 25. Setting it to a larger value may increase the probability of success
for the advancing front method, but will also lead to more poor quality tetrahedra, and vice

versa.

e Enhanced Splats module (volume rendering for tetra grids): Now supports arbitrary

colormap, sorting, ROI.

e Enhanced ChannelWorks and Arithmetic modules: Surface fields are now supported as

well as well as grid fields.
e New module LatToHex: Converts 3D lattice into hexa grid.

e New module TriangleDistortion: computes various metric distortion measures between

surfaces having the same connectivity.
Changes in optional readers

e Enhanced SEG-Y reader for improved robustness and performance. Note also: SEG-Y can
be converted to LDA format. A new predefined colormap relevant for seismic data is

available (seismic.col). SEG-Y fences can be visualized with the CurvedSlice module.
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e Enhanced reader for DICOM file format: Loading DICOM data is divided into two loading
steps now. In a first step only the meta information is read and presented within the DICOM
load dialog. Thus, loading large image series (e.g via DICOMDIR) leads to a much quicker
response for the user. Images can be inspected within the DICOM load dialog via the right
mouse button option "preview image". After final selection of images or image stacks, pixel
data are directly loaded into a newly allocated 3D scalar field representing an image stack
in Amira, thus allowing larger image collections to be read due to more efficient memory
handling. See also: Shear module has been enhanced with automatic shear angle

extraction from DICOM data.

e New CAD readers: optional readers for CAD geometry formats: CATIA 4, CATIA 5, IGES,
STEP.

Changes in Amira VR Pack (Formerly AmiraVR)

e Enhanced cluster support: easier management of slave nodes through automatic services.
Robustness has been improved. Restarting Amira on a slave node can be triggered from
the master node. Loading a new cluster configuration now automatically removes all visible

objects from the pool for convenience.

o Enhanced stereo user interface: New ports are available in AmiraVR module, for left and
right eye offset with immersive configurations, or for offset and parallax ports with flat
configurations. Access to viewer's stereo settings (Open Inventor) is disabled when using a

VR configuration.
e Improved navigation interaction with mouse with flat tiled screen configurations.

o Enhanced interaction in cluster configuration: manipulation and interaction are enabled on

master node. Both are disabled on slave nodes.
e Enhanced Transformer and TabBox manipulators for wand interaction.
e Improved wand navigation (an offset was introduced in some cases).
e Extended support for Mouse Mode: it works now also on Windows platforms.

e New port in AmiraVR module to disable wand highlighting. This can increase performance

while viewing in some cases, by avoiding on-the-fly picking in complex scenes.
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e Improved reader dialogs: Dialog boxes coming with readers for basic image formats, raw
data, Fluent and I-DEAS now appear on the master only when using a cluster

configuration.

e Improved 3D ports: FloatTextN is now continuously refreshed in VR configurations. Fixed
issue with wand grabbing by FloatTextN ports and menu buttons. 3D buttons activation is
now connected to the "clicked" signal instead of "pressed". HxPortButtonMenu now has a

3D representation. HxPortGeneric now has a 3D representation

e Editor buttons are currently disabled while in cluster mode. Editors can still be activated

though Tcl scripts (e.g. create [create HxIvEditor] attach data).

e Enhanced support for VR configuration files: Configuration files can be picked up from any
location, not only AMIRA_ROOT/share/config. AMIRA_VR_CONFIGS_PATH can be used
to set a different location. At runtime, a new item in VR menu is available: "Change Configs
Path...".

o New node SoVRProperty node in configuration files: New fields to show or hide Amira main
window, console or cursor on slaves: showSlaveGU| showSlaveConsole
showSlaveCursor. As interaction is disabled on slaves, a "forbidden" cursor is used. By

default the cursor is hidden.

e Improved LogoDisplay: Logo Display does not blink anymore and no longer interferes with

the viewAll.

e New Tcl command for display toggle per screen: Object command "setScreen" limits
display to given list of screens, -1 for all. Useful, for instance, for LogoDisplay, Annotations,

legends...

e New Tcl command "app cluster" to check if Amira is running on a master or a slave node.

Returns one of "single", "master”, or "slave".

o Enhanced VR Pack event handling for custom modules (see changes in Amira Developer
Pack)

Changes in Amira Developer Pack (Formerly AmiraDev)
o Extended public API for Amira developers. More headers now distributed and more Amira

classes are exposed. Reminder: headers may not be provided for some classes, in order to
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e New classes for managing OpenGL extensions.

e New classes for thread management.

e New mechanism for extensibility based on interfaces.
e New classes for numeric packages.

o HxDataMapper base class for mapping modules: e.g. take input data and present them in a
different way but have no internal state beside ports (i.e. cannot be saved). Placing of Data

Mapper modules similar to normal data modules

o New Tcl command "getPackage" to get the name of the package this object belongs to. Tcl
Command "all" extended. Option "-classesof &ltpackagename>" returns all classes

belonging to the given package.
e Tcl variable TMPDIR introduced.

e Added -ccheck option to module command: -ccheck allows to specify an extern "C"
function of signature, "int check (McTypedObject* obj, const char* userDat)". This function
will be called by the object popup. If it returns 0, the module will not be available (similar to
-check). You may specify a lib different from the module lib by -ccheckpkg. You may

specify user data by -ccheckdat.

e Enhanced VR Pack event handling: Custom VR event handlers can now handle valuator
information from controller. Default event handler can be overridden by custom event
handler using name "pick", for instance for interfacing multiple or specific devices through

custom modules.
Changes since Amira 3.0

e New: Support for Linux Itanium 64

o Slice aligner: Also works on LargeDiskData objects, which are not stored completely in
main memory, better interpolation when resampling images, new resize option allowing the

result to be bigger than the input image, new edge-based alignment algorithm, better
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Direct volume rendering with the Voltex module: Instead of palette textures a pixel shader
program is used now yielding higher quality images for high-frequency colormaps, support

of compressed textures if available

StandardView module: Now also supports RGBA color images, also a second 3D data set
can be superimposed by means of blending, add or max intensity operations, or a

checkerboard display

New module for multi-modal image registration. For example, CT and MR data can be
aligned easily. Different criteria such as least squares or normalized mutual information are

available. This module is explained in a new tutorial.
New reader for the SEG-Y data format.

Extended support for the Leica confocal image format (multi-channel images and time-

dependent data)

New image filters: Existing filters have been revised and new filters such as Gauss 2D or
Sobel filters have been added. All filters now can not only be applied in an editor but also in

a compute module.

New semi-automatic segmentation tools: The segmentation editor provides active contours

that move automatically towards the object boundaries.

Script objects: more examples for writing Amira script objects, ready-to-use script objects
for creating and playing back demos (DemoMaker and DemoSequence). An online

documentation for script objects can be created
Improved movie maker: support for creating stereo movies

Improved stereo movie player: it can convert a movie consisting of a sequence of separate

image files into a compressed-texture format suitable for fast playback.
New module to generate arbitrary parametric surfaces from analytical expressions.

New module ConePlot to visualize vector fields by animated cones.

39



New system information dialog: version information of all Amira components now can be

easily obtained, including a list of installed patches

Improved JPEG output, added Tcl variable AmiraJPEGQuality (0...100)
Improved |0 of ply files (endianess issues, colors per vertex)

Support for AVS UCD files with time-dependent data

InterpolateLabels: improved quality of the interpolated data, can now also be applied to

label fields with stacked coordinates

Extended export of reconstructed 3D models in VRML

New module SurfaceCut that displays cross-sections through surfaces separating different
regions. Each region in the cross-section is filled and displayed with its respective color.

Previously, similar cuts could only be computed for volumetric tetrahedral grids.

Two new items have been added to the File menu, allowing to quickly reload the files and

networks which have been accessed most recently (Recent Files, Recent Networks).

Improved documentation of global Amira-specific Tcl commands. All these commands are

now listed in a common reference section in the User's Guide.

Includes all patches for Amira 3.0 and many more bug fixes

CHANGES IN AmiraDev:
New: Support for Visual Studio .NET

A new, fully automatic system that creates GNUmakefiles, Visual Studio 6 project files, and

Visual Studio .NET project files.

AmiraDev is now based on Open Inventor 4.0 and uses new platform-independent SoQt

classes instead of SoWin classes on Windows and SoXt classes on Unix

Strict separation between Hx* classes not depending on Qt and Qx* classes depending on

Qt (implies renaming of some previously undocumented Amira classes)

Headers of more Amira packages are included now: hximproc providing access to the

Amira image filters, hxvertexset providing access to the Amira sphere rendering node
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¢ New tool doc2html allows to create an online documentation for custom modules and 10
routines. A new section in the programmer's guide explains how to create such

documentation.

CHANGES in AmiraVR:

e New AmiraVR cluster extension, allowing to run Amira on a graphics cluster driving a multi-
wall display system. This extension allows it to start multiple instances of Amira in a
synchronized way. Each instance is responsible for rendering one particular wall or set of
walls. It is possible to load standard Amira networks and to interact with the modules via

the 3d menus or via the Amira script interface.

e Improved mouse interaction for standard AmiraVR. In both planar and non-planar
configurations you can now interact with the 2D mouse without any restrictions (pick slices,
move draggers, etc.). Event processing for screens on a remote display is much faster

now.

e Improved 3d menus: Possibility to constrain the menus to the screen plane, making
interaction more easy. Possibility to customize the top-level menu, and not only the user

menu. Possibility to interact with the 2d mouse in a VR config.

e Improved AmiraVR API: An easy way to define geometry in fixed world coordinates in a
module, a new class HxVREnvironment allowing to access all parameters of the current

VR configuration from a user module.

e More demo modules, illustrating how to interpret Open Inventor tracker events and

controller button events, and how use multiple trackers.
Changes since Amira 2.3

o Slice aligner: reduced memory consumption, new option to align images with respect to a

fixed slice
e« New module HxDisplace for applying displacement vector fields to geometric models

o Support for TeraRecon's VolumePro 1000 volume rendering hardware including combined
geometry and volume rendering and volume rendering of large 3D image stacked (images

must not reside in main memory).
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Point probe module: new option for computing an averaged data value inside a sphere
Line probe module: option for converting a line probe into a line set

New module for displaying a test pattern for passive stereo projection

Improved annotation module (multiple lines)

New scripting guide. Revised Tcl commands for all data objects and modules. Better
documentation of the Tcl commands. In order to get the help text for a command or for a

port just type in the command in the console window and press the F1 key.
Better Tcl error messages.
New DICOM 3.0 export, improved DICOM 3.0 import (image preview)

New image segmentation editor features, including improved region growing, translation
and rotation of selected areas, option for rotated or flipped views, new wrapping tool, new
selection replace option in addition to add and subtract, way to create template label fields

with predefined materials

New option tile in the snapshot dialog, which allows generating snapshots with arbitrary

high resolution.

Creation of snapshots with an alpha channel for later image compositing (viewer 0
snapshot -alpha &ltimagefile>). With this option two snapshots are taken, one with a black
and one with a white background. From these images the correct color and alpha values

are computed.
Possibility to write snapshots in DICOM 3.0 format.
Renamed the GMC module for surface generation to SurfaceGen.

Improved smoothing of label fields: new algorithm guarantees that no label is changed by
the smoothing operation. The new option is available as an option in the SurfaceGen
module. This is a major enhancement allowing to reconstruct much better surfaces in many
situations. The old smoothing in the image segmentation editor (smooth labels 3D) is still

available.

New features for dealing with large disk data (LDD concept). Very large regular 3D data

stored on disk can be quickly accessed in parts or in low resolution. For fastest access a

42



New Region-of-interest concept. ROI's can be defined either using the new SelectROI
module or implicitly using an LDD-Access module. Standard modules such as LineSetView
or all module derived from HxViewBase (Isosurface, SurfaceView, GridVolume, HexaView,
...), can be connected to a ROI provider. Then the view will be automatically restricted to
the ROI.

New module for displaying boundary faces in a hexahedral grid.
Support for the the Leica TIFF image format.

New -proc option for the module or dataClass Tcl commands used to register objects in
Amira .rc-files. With this option a Tcl procedure can be defined which is called right after
the object is created. This allows e.g. to modify the default settings of an existing module. It
also allows to create popup menu entries for virtual objects (just omit the -class statement).
When selecting such an entry no object is created but just the Tcl procedure will be

executed. With the same mechanism ScriptObjects can be added to the popup menu.
New module for creating MPEG files directly from Amira (MovieMaker).

New CameraRotate object for producing simple animations. The MovieMaker module can

be directly connected to this object.

New module VolumeEdit for modifying a 3D image with 3D drawing tools. Useful for 3D

image segmentation and background/noise removal.
Improved TissueStatistics module. New options area per slice and volume per VOI.

New Grouping module allowing to define arbitrary groups of elements in all modules
derived from HxViewBase (SurfaceView, GridVolume, HexaView, etc.). The grouping
module is connected to one or more of these display modules. It allows to define and select

groups. The groups can be stored in AmiraMesh files or in network scripts.

Improved time series control module. The module now optionally allows to interpolate
between different time steps (surfaces and surface fields, tetrahedral and hexahedral grids

and associated data fields, any other data type derived from HxVertexSet).
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New module CuttingPlane. The module defines cutting plane (via an Inventor dragger). It
then cuts all geometry in the scene with this plane and produces a line set. Connected line

segments are identified.

New module SurfDistance. Computes the Hausdorff distance between two arbitrary

surface.

New module AlignSurfaces. Aligns two arbitrary surfaces so that the Hausdorff distance is

minimized. The surfaces need not to have corresponding points.

New module AlignPrincipalAxes. Aligns two arbitrary data objects derived from
HxVertexSet (e.g. surfaces, grids, or point clusters) so that the center and the principal

axes of both inputs match.
New module SurfaceNormals for visualizing the normals of a surface.

VertexMorph module replaced by new Interpolate module. The new module optionally also
interpolates data fields connected to a grid or to a surface, or it optionally interpolates the

grid or surface if connected to a field defined on such objects.

New module TetraVectors. Visualizes the vectors of a vector field defined on a tetrahedral
grid. Can be connected to GridVolume or GridBoundary. Vectors are displayed on the

elements selected by these modules.
New module StreamRibbons. Computes ribbons in a vector field.

New module Animate. Allows to animate standard Amira ports (sliders and numerical text

fields) using a single Time object.

Significantly improved Arithmetic module. Now operates on all fields on regular,
tetrahedral, and hexahedral grids, as well as on surface fields. Can compute n-component

result instead of only a scalar one.

New module Merge. Combines an arbitrary number of possibly transformed 3D images into
one big resampled image using distance based interpolation. Useful for reconstructing 3D

models from objects which are scanned in in different parts.

Colormap icons are shown in the popup menu of PortColormap. Colormaps can be loaded
and edited directly from the popup menu. Better representation of transparent colormap in

the user interface.
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e Improved colormap editor. New menu 'Extras' allowing to set predefined colormaps.

Smaller brush for interactive editing of a channel function.

o New local range feature for PortColormap. Previously the colormap range was always
taken from the colormap object itself. Now it is possible to define a module-specific range

in PortColormap.

o Before quitting Amira now it is checked if any data object or the current network need to be

saved. These checks can be disabled or enabled in the preferences dialog.

o Transformed data sets are shown in ltalics in the object pool. Modified data sets are

marked with an asterisk.

o Significantly improved transform editor. The editor now provides an optional dialog allowing
to define absolute or relative transformations exactly using text input field. For vertex set
objects the editor now also provides an 'Apply Transform' button. Transformations can be
copied into and pasted from an internal buffer. This makes it possible to copy a

transformation from one data object to another very easily.

e Improved Curvature module. Now allows to compute the mean curvature, the Gaussian

curvature, the maximum curvature, or both main curvature values or their inverse values.

e New module LegoSurface. This module reconstructs a surface from a label field like

SurfaceGen, but the surface exactly matches the voxel boundaries.
e Improved online help. Module and editor indices contain short explanation now.

e Better support for color fields with stacked coordinates. In particular, the modules

CastField, OrthoSlice, and ObliqueSlice now support such input.

e Many bug fixes and minor improvements.
Changes since Amira 2.2

o Slice aligner: new tool for manual and automatic alignment of 2D slices in a 3D image
stack (facilitates reconstruction of geometric models from mechanical/histological cross

sections, tutorial and demo included).

45



New features for interactive image segmentation, e.g., a wrapper tool, allowing to
interpolate 3D shapes from just a few segmented slices, or smoothing by means of

morphological operations

Option to view the current selection and segmented regions in the image segmentation

editor in 3D. The selection can also be edited, e.g., cropped away, in 3D.

New interactive tool for surface editing (move points, flip edges, collapse edges, refines

triangles, delete triangles, define new triangles, specify boundary condition IDs and more)

Better support for multi-channel images (individual channels can be grouped into one
object, editors and modules can work directly on the multi-channel object, this includes

OrthoSlice, ObliqueSlice, ProjectionView, Resample, CropEditor, and Voltex).

Better support for time-dependent data using a time step controller (caches and replaces
individual time steps on request, can be invoked via "Load Time Series..." option of the file

menu)
Improvements and new tools for measurement (lengths and angles)

New options for resampling: specify voxel size of output data set, take dimensions and/or

resolution of output from reference object

New module ApplyTransform (resamples transformed 3D image onto new grid with identity
transformation, resamples 3D image onto a new grid oriented as defined by a slicing

module)

Improved quality of reconstructed surfaces (compactify option and option for edge

contraction in the GMC module)

"Virtual slider" in text fields (shift-click into a text field displaying a numeric value and move
the mouse while keeping the mouse button pressed in order to change the value, mouse

wheel works as well)

Volume rendering: support for palette textures and SGI/HP color table extension (less
memory consumption, improved performance), real-time selection of subvolumes via a
tabbox dragger (can be activated using the command "Voltex showBox 1"), much less

flicker when rotating objects in 2D texture mode
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New file formats: BioRad confocal images, Metamorph STK format, Fidap neutral file

format, I-DEAS file format, Analyze 3D images

Improvements for many existing file formats: ZEISS LSM (16-bit, multi-channel), Leica 3D

(memory handling), Fluent (boundary ids)

Instead of the bounding box now on default the voxel size can be entered in the crop
editor, the read raw dialog, and the channel conversion dialog. The bounding box option is

still available, too.
Improved console behavior (TAB auto completion, less flicker)

Redesigned DICOM import dialog: DICOM files are listed in a table and can be sorted

according to different criteria such as series id, file name, z position, date.

ProjectionView: new option for combined pseudo-color display of both the projected values
and the depth information (max + depth), support for projection of subvolumes (restrict

option)

New module ProjectionViewCursor (can be attached to a ProjectionView, shows location of

the voxel containing the maximum value).

New module VertexMorph for interpolating between two vertex set objects (e.g. surfaces)

with the same number of vertices

New module Histogram for computing histograms for any scalar field regardless of the

coordinate type.

New module CorrelationPlot for plotting the correlation matrix of two regular 3D input
images of the same dimension. Possibility to segment the images by manually drawing

contours into the correlation matrix.

New module SurfaceArea to compute the surface and/or the volume of the different

patches or regions of a surface.
Enhanced version of the DistanceMap module.

New option "pack & go" option for exporting network scripts. New preference dialog for

further customizing the save network behavior.
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e Viewer toggles are shown on the icons in the object pool (objects don't need to be selected

any more in order to change the viewer mask).

e New modules selected from a parent's popup menu are automatically selected now

(behavior can be turned off in the preferences dialog).

e Performance improvements for illuminated field lines (DisplaylSL module) on several

platforms like Windows/NVidia

o Better support for transparencies in slicing modules such as OrthoSlice and ObliqueSlice

by use of OpenGL's alpha test function
e Surfaces may now have more than 32767 patches.

e Snapshots are always written as 3 channel RGB images, not RGBA. Improved

compatibility of exported TIFF files with Windows applications.
e Support for a user-defined material database.
e Specification of colors in the parameter dialog via a color chooser.
e Data in plot window can be saved in Excel csv format.

e Amira 2.3 is based on the newest releases of Open Inventor (version 2.6.2), Qt (version
2.3.1), and Tcl (version 8.3.2)

e All patches released since Amira 2.2 are incorporated in the new version for all platforms.

This includes bug fixes as well as functionality enhancements.

e Starting with Amira 2.3 a separate option called AmiraMol is available for the visualization

of moleculs (see ReleaseNotes for AmiraMol).

o Starting in Q3/2001 a separate option for resolution enhancement by computational

deconvolution will be available (AmiraDeconv)
Changes specific to AmiraDev 2.3

o New data type HxTime and associated port/interface HxPortTime

o New API for defining time-out methods/functions for animation tasks
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Two new example modules in the demo package illustrating the new concepts

(MyDynamicColormap, MyAnimateColormap).
Support for multiple result objects in compute modules (HxCompModule).

Parent objects are now being notified if down-stream modules connect or disconnect
(HxObiject).

New evaluator interface allowing the user to define higher-order interpolation methods for
3D data fields

49



	Amira 5.2.1 – Release Notes
	Supported Platforms
	System Requirements
	Recommended Hardware
	Supported Compilers for Developer Option

	Changes since Amira 5.2.0
	 Enhancements
	Bug fixes

	Changes since Amira 5.0.1
	Known Issues

	Changes since Amira 5.0
	Changes since Amira 4.1.2
	Changes since Amira 4.1
	Changes since Amira 4.0
	Changes since Amira 3.1.1

